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1. Introduction
JUSTIS 5 is the latest version of the JUSTIS full-text search software from Justis Publishing
Limited.  Justis Publishing is the leading UK electronic publisher of UK and European legal and
governmental databases, publishing a range of CD-ROM and Internet products.  JUSTIS 5
incorporates a full-text retrieval engine licensed from Fulcrum Technologies Inc. and Justis
Publishing’s own development – J-Link, a dynamic document linking engine.  JUSTIS 5 allows
the end-user to search across databases and across different CD-ROMs, and even to
simultaneously search databases on CD-ROM drives and databases downloaded to a local or
networked hard disk.  With J-Link facilitating cross-referencing across the same range, JUSTIS
5 offers the user a single fully-integrated interface for a wide range of electronic titles.

JUSTIS 5 allows you to create queries using different options suitable for users with any level
of experience.  You can edit queries, browse indexes and create your own dictionary of search
terms.

You can switch freely between any JUSTIS 5 databases during a single search session without
reloading the interface software, making it easy to share search strategies and compare results.

Once you have retrieved a document, you have a wide range of navigation facilities, and you
can mark documents and add your own notes.  A scroll bar on the side of the screen shows
your relative position within the document.  Comprehensive printing and downloading
facilities allow you to store or print hit references, complete documents or extracts from
documents. 

The look and feel of JUSTIS 5 was developed after Context Limited (as Justis Publishing was
thenknown) was invited by the Incorporated Council of Law Reporting for England and Wales
to develop a CD-ROM version of The Law Reports.  Covering 130 years of case law, the
fundamental importance of this product to the legal profession required a fresh approach.  A
major independent study of the way the legal profession would use an electronic version of
the leading case law series was commissioned by the Council and was undertaken by the Law
Technology Centre at Warwick University.  The result of this study, together with feedback
from the large body of users of Justis Publishing’s other case law series, led to the development
of JUSTIS/LR.  This software has now been further developed into JUSTIS 5 for use with the
full range of UK and EU products.

1.1 How to Use This Manual

This manual includes detailed information on the functionality and layout of the JUSTIS 5
software.  You may not need to use all of the functions on offer.  If you are in a hurry to start
searching a database and the JUSTIS 5 software is already installed, you should read the
following sections first:

4.1 Selecting a Database

6.2 Performing a Quick Search

10.1 Viewing Profiles

11.1 Navigating Within a Document

14.1 Marking Documents

Or, if you already know how to select the database(s) you want to search, Section 3 offers a
very quick tutorial.

The JUSTIS 5 software is used for a whole range of CD-ROM databases.  This user manual
covers the functions of the software rather than the database contents.  Descriptions of the
databases and the fields that they contain, plus tips on searching each database, are provided
in the User Guides that form part of the on-screen Help files.

You can get detailed help displayed on your screen at any time while using JUSTIS 5 by
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pressing the F1 key on your keyboard or by selecting Contents & Index from the Help menu
on the menu bar.  Additional materials and training are available from the Training Team in
the Customer Relations Department at Justis Publishing.

1.2 JUSTIS 5 Software and Terminology

JUSTIS 5 contains a search screen from which you may select one of three screens to carry out
a search: Quick Search, Form Search and General Search screens.  You can also browse
through the documents in a database on the Contents screen  (See Supplement Section 1).

Once a search has been completed you can display the results on the Profiles screen, and
then display a complete retrieved document on the Document screen.  These screens are
introduced in detail in the following sections.

1.2.1 Definition of Terms

Button A fundamental part of Microsoft Windows, buttons are found in most
windows, screens, dialog boxes and message boxes, often carrying a label or
picture to indicate their function.  When clicked, they cause a function to
be performed.  May be grouped together on a toolbar or button bar.

Database A file that contains the documents found in a product.

Dialog Box Dialog boxes are windows within JUSTIS 5 that contain elements such as
buttons and text boxes that allow you to supply instructions or information
to the program.

Field Names Provide you with rapid access to salient portions of each document.  Field
names vary depending on the database, and are listed by the Outline button
on the toolbar of the Document screen.

Hit A term used to describe retrieved documents resulting from a search.  For
example, a Search Query may result in 20 Hits.  The Profiles screen displays
a profile of each Hit.

J-Link A dynamic document linking feature which enables you to link to
referenced documents.  J-Link interprets information such as publication
reference, title or case name, and, where possible, displays the relevant
document.

Menu bar The bar containing a series of words or commands (e.g. File, Edit, View,
Tools, Window, Help) at the top of each screen.  When you click on these
words a drop-down menu is displayed offering further options.

Message Box Message boxes are small windows within the JUSTIS 5 program that provide
you with relevant information.

Operator A general term for any device used to relate (or exclude) terms in a query.
JUSTIS 5 uses Boolean operators and others to narrow or broaden searches
by combining or excluding disparate information.

Profile A summary of a document retrieved after performing a search.  It contains
salient information on a document to help identify it, i.e. document
reference, title and summary.

Search Query The term(s) you use to look for relevant documents, together with any
connecting operators such as AND, OR or NOT.

Search Session From the point that you start JUSTIS 5 to the time that you exit.  You can
undertake any number of searches within one session.

Search Terms Individual words used within a Search Query.  The specified terms are
displayed in blue in the retrieved document.
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Toolbar The row of pictorial buttons displayed just below the Menu Bar on the
JUSTIS 5 screens.  The buttons enable you to carry out specific functions, e.g.
select a database, go to profiles, go to document.

Wild card A special character that is used to represent one or more actual characters in
a Search Term.  Allows you to easily search for all words that start with the
same letters, or for singular and plural versions of a word, or for British and
American forms.

3

JUSTIS 5 USER MANUAL



4

JUSTIS 5 USER MANUAL



2. Installing JUSTIS 5

2.1 System Requirements

Minimum Recommended

Processor Pentium P 100 Pentium II P300 or faster

RAM 16 MB 128 MB

Operating System Windows 95 or Windows 2000 or
Windows NT 4 Windows XP

Disk space 75 MB (for software) 100 MB (for software)

CD drive Double speed Quad speed or faster

2.2 Installation

If you are using Windows 2000 or Windows XP, we strongly recommend using JUSTIS 5.31; if
you have an earlier version, please contact the Help Desk and request a new software 
CD-ROM.

The JUSTIS 5 software is normally supplied on a white CD-ROM.  Insert the software CD-ROM
disc into the CD drive of your computer.  If the Setup program does not start automatically:

1) Click the Start button on the Windows Task Bar

2) Click Run…

3) Type d:\setup (where d is the letter of your CD drive)

4) Click OK

You are now presented with the JUSTIS 5 Setup screen.  Follow the on-screen instructions to
carry out the installation.  If you need assistance, please do not hesitate to call the Justis
Publishing Help Desk (See Section 18).
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3. Quick Tutorial

This tutorial is the briefest possible explanation of how to use the JUSTIS 5 software.  We
highly recommend that you read this User Manual in its entirety to get the best use from your
investment in JUSTIS 5 CD-ROM  services.

1) Double-click the JUSTIS 5 icon on your desktop (if you opted for one during Setup),
or else click the Start button on the Windows Taskbar, point to Programs and then
to Context, and then click the JUSTIS 5 icon to start the program.

You are presented with the Select Databases dialog box.

2) Click on a product or database in the left pane and then click the Select button.  Click
OK to start your search session.  (See Sections 4.1 and 4.2 for more details.)

3) On the Quick Search screen, click the first of the available buttons, e.g. Parties, Title
or Heading.  In the dialog box that appears, type a word that is likely to appear in the
database.  For example you could type:

shipping
health
crime
pollution

4) Click the Search button (or press Enter on your keyboard).  A  box appears on your
screen counting the number of documents your query has found.

5) If no documents are found, click again on the first button in the Quick Search screen
and try typing in a different word.  If a very large number of documents is being
found, click the Cancel button to stop the search.

6) To display the results of your search, click the Yes button.  To display the results with
the oldest record first, click the check box in the Search dialog box before you click
Yes.

7) The Search screen is replaced by the Profiles screen, with a list of references
displayed. (See Section 10 for details on viewing profiles.)

8) Select one of the references by double-clicking it with your mouse (or by clicking it
once and pressing Enter on your keyboard).

9) The Profiles screen is replaced by the Document screen.  (See Section 11 for details on
viewing a document.)

10) To save or print this document, click the File menu, select either Export... or Print...,
and follow the on-screen instructions.

11) Use the buttons on the toolbar near the top of your screen to move back and forth
through the Query, Profiles and Document screens.

Press the F1 key on your keyboard (or select Contents & Index on the Help menu) at any
time to see the on-screen Help.
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4. Choosing Databases

After starting JUSTIS 5 you will see a copyright message followed by the Select Databases
dialog box.  The left-hand window displays a full list of the CD-ROM products currently
available from Justis Publishing.  If the database selection menu has been customised, only
products and databases marked as available (with a tick) can be selected.  When JUSTIS 5 is
installed for the first time, no ticks are displayed, and any database can be selected.  If you
wish to avoid the confusion that can result from trying to select an unavailable database, you
can customise your menu by marking the products to which you subscribe.  (see Section 15.3
Databases Options for instructions.)

4.1 Selecting a Database

The Select Databases dialog box displays a number of icons to assist in selecting a database.

Icon Name Definition

Folder A range of related databases.  This can be either one product, e.g.
English CELEX, or a collection of products, e.g. Case Law.

Database An individual searchable database held within a folder.  This can be
either a single product, e.g. The Times Law Reports, or one of a number
of databases contained in one product, e.g. the Legislation database in
CELEX.

To display the CD-ROM databases:

1) Click the CD-ROM tab.

2) Double-click an appropriate folder (or click the ‘+’ symbol to the left of a folder).

This will display all the databases held within that folder, in a tree-like structure.

You can view the User Guide for a database, even if you do not subscribe to it, by clicking it
and then pressing the F1 key on your keyboard.

There are three different ways to select a database:

• Click the desired database to highlight it, then click the Select button at the bottom
of the Context Databases window.
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• Or double-click the desired database.

• Or click the desired database and, keeping your mouse button depressed, drag and
drop the database icon into the Selected Database(s) window.

The selected database will now appear along with its parent folder in the Selected
Database(s) window.

You can select as many of the databases to which you subscribe as you wish.  Click OK when
you have selected the database(s) you wish to search.

After a copyright message, you will see the Search screen (see Section 6).  To return to the
Select Databases dialog box at any time:

• Click the Database button on the Toolbar.

• Or select Databases… on the View menu.

4.2 Scanning for Databases

If you take out a subscription to a further Justis Publishing product, you need to update JUSTIS
5 so that it is aware of the additional database.  This is especially necessary if the CD-ROMs
are accessed over a network or if the contents of a CD-ROM have been copied (using the
Transfer utility - see Section 17.4) to a hard disk accessible over a network.

1) Mark your new database(s) as available (see Section 16.3).

2) Click the Scan button in the Select Databases dialog box.

3) In the Database Manager – [Scan] dialog box that appears, type the location of the
new databases, using either the DOS convention or the Universal Naming
Convention (UNC), and then click OK. For example:

\\SERVER\CDROM_3
\\SERVER\PROGRAMS\JUSTIS
H:\

Alternatively, JUSTIS 5 will scan all available drives if you click OK without specifying
a drive.

4.3 Loading Selected Databases at Startup

You can customise JUSTIS 5 to automatically load selected databases at start up, to save you
having to select databases every time you run the software.  This is especially useful if you only
subscribe to one JUSTIS 5 title or if you normally search the same selection of databases.

1) In the Select Databases dialog box, select the database(s) you wish to have loaded
automatically on start up.

2) Click the Load selected database(s) at startup check box at the bottom of the
Select Databases dialog box.

3) Click OK.

The next time you start JUSTIS 5, your selected database(s) will be loaded automatically and
you will be presented with the Query screen.  To subsequently change your selection, click the
Database button on the toolbar.

4.4 Selecting Multiple Databases

A key aspect of the JUSTIS 5 software is its ability to search across more than one database at
a time.  This is especially useful when searching related databases, e.g. Legislation and
Proposals in CELEX, or Weekly Law Reports, The Law Reports and Family Law Reports.
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To select and search multiple databases, you must have simultaneous access to the databases
from more than one CD drive, across a network, or from your hard disk.

To select multiple databases:

1) Return to the Select Databases dialog box by clicking the Database button on the
toolbar.

2) Double-click the desired folders to display the databases they contain.

3) Select one or more databases, either by double-clicking or by clicking on the database
and then clicking the Select button.

To select a folder and all the databases it contains:

1) Click a folder.

2) Click the Select button.

The databases and/or folders you have selected will appear in the Selected Database(s)
window.  There is no restriction on the number or combination of databases and folders you
may select.  However, combining different folders, or databases from different folders, may
restrict your Search screen options (see Section 6).

If you select Save program state on exit in Admin Preferences (see Section 15.2.8), JUSTIS 5
will remember the databases that you have selected.

4.5 Changing Databases During a Session

After searching your current selection of databases, you may wish to change that selection.

1) Return to the Select Databases dialog box by clicking the Database button on the
toolbar.

2) In the Selected Database(s) window, highlight any databases or folders you no
longer wish to search and then click the Remove button.  (You can also drag and drop
them back into the Context Databases window.)

3) Select new databases or folders, either by double-clicking, or by clicking on them and
then clicking the Select button.

4) Click OK.
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5. Searching Tools

JUSTIS 5 provides a full-text retrieval engine.  This means that you can look for words or
phrases, anywhere in any document, in any databases you have available to you.  Before using
the Quick, Form or General search screens, it is useful to understand the underlying search
tools and techniques that are available. 

5.1 Search Operators

The JUSTIS 5 search language provides a powerful way to control how the words or phrases
being searched for (also known as the search terms) are interpreted.  Operators are used to
combine and exclude search terms.  Wild cards are used to allow for different spellings of
terms.  Parentheses organise the query logically.

The various operators can be used with most of the search options.

Operators are shown on screen in blue, to distinguish them from your search terms 

5.1.1 Boolean Operators

Boolean operators combine and exclude terms in a particular way.  The three operators are
and, not and or.  Each can be represented by a symbol that works in the same way.

Operator Example Meaning Symbol

and A and B Documents must contain both A and B. &

not A not B Documents must contain A and must !
not contain B.

or A or B Documents can contain either A or B or both. |

And and not are useful if you need to narrow a search.

Or widens a search so must be used with care.

If any of the words in your search query appear in blue, this shows you that they are operators;
you need to enclose the term in double quotation marks, for example “health and safety”.

5.1.2 Wild cards

Wild cards are used in place of characters in a word.

Wild card Meaning Example

* Any number of characters at the end of liab*
a word finds liability, liabilities,

liable, etc. 

? Any single character anywhere in a word Compl?ment 
finds compliment and 
complement. 

- A space, no space or a hyphen Data-base
finds data base, database
and data-base. 

Wild cards can save you having to enter a number of different spellings of the same word.  The
* wild card is particularly useful for plurals, however it does broaden the search and should be
used with care.  If you search using the Form Search or General Search screens, you can use
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the Word Index instead to select alternative spellings of words with a common root (see
Sections 7.3 and 8.3 for more information).

5.1.3 Parentheses

Parentheses organise the whole query logically.  For example, a search for:

air and (pollution or emission)

finds documents where the terms air and either pollution or emission are present.  Without
parentheses, JUSTIS 5 would find documents featuring both air and pollution plus documents
featuring emission on its own.

5.1.4 Phrase Searching

When searching for a phrase you can simply type in the whole phrase and JUSTIS 5 will locate
it, for example:

air pollution
professional negligence

When you search for a phrase containing a word or symbol that functions as a Boolean,
proximity or date operator, such as duty of care or health and safety, behind the scenes it is
automatically changed to a proximity search (see below).  For example, a search for:

duty of care

is treated as if you had typed:

duty within 2 before care

It is not normally possible to search for a phrase that starts or ends with an operator.

5.1.5 Proximity Searching

Although the and operator ensures two terms exist within a document, it does not specify any
relationship between them.  Proximity operators determine the maximum distance between
two terms.

Example Meaning

A within 25 of B A must be within 25 characters of B.

A within 40 after B A must be within 40 characters of B, and must be after B.

A within 10 before B A must be within 10 characters of B, and must be before B

A near B A must be within 40 characters of B.
It is the same as A within 40 of B

Proximity operators are very useful when searching for phrases, especially when a document
may have been translated from another language.  For example, product liability may have
been translated as liability for the product.  To find all mentions of the phrase, you should for
example search for:

product near liability

In the English language, 25 characters is approximately 5 words.  Use any number of
characters you wish, although 10, 25 and 50 are the most common.

The near operator is fixed at 40 characters.

Some common distance requirements for use in proximity searches are shown below.  For
greater distances, use a simple and search rather than a proximity search.
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Proximity Equivalents Characters

Within 1 or 2 words 10

Within 5 words 25

Within 10 words (1 sentence) 50

Within a long sentence 100

Within 1 to 3 paragraphs 500

5.1.6 Date Operators

Some JUSTIS 5 databases contain date information in a special format that allows you to
search for a range of dates; consult the User Guides in the on-screen Help to see which fields
can be searched using date operators.

The DATE operators are:

Operator Symbol Definition 

AFTER > After the date 

BEFORE < Before the date

ON = On the date

FROM Range start (use with TO)

TO Range end (use with FROM)

Dates must normally be searched for within a specific date field, e.g. the Pub field (publication
date) in CELEX or the Year field in UK Statutes.  If you were looking for documents within a
range of dates, your search would look like:

Date[from 1 Jan 1997 to 30 Jun 1997]
Date[after 1/3/96]
Year[from 1996 to 1997]

You can type a date for searching in a number of different formats.

Format Example 

dd/mm/yy 25/11/97
dd/mm/yyyy 25/11/1997 
dd mmm yy 25 nov 97
dd mmm yyyy 25 nov 1997
dd mmmm yyyy 25 november 1997
mmm dd yy nov 25 97
mmm dd yyyy nov 25 1997
mmmm dd yyyy november 25 1997
yyyymmdd 19971125

Names of months can be in full, or 3-letter abbreviations (with or without a full stop), with or
without an initial capital.  Dates that begin with the names of months can optionally have a
comma after the day.
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You can combine DATE field searches with other types of searches, for example in the General
Search screen:

pension and age and DATE[after 25/11/94]
FORM[regulation] and DATE[from 1 jan 96 to 31 dec 97]

Specified ranges are inclusive, i.e. the search will include the FROM and TO dates.

5.2 Fields

All the information in a JUSTIS 5 database is contained in fields.  One field contains a
particular type of information that is held in an individual section or paragraph of a
document.  In a free text search, JUSTIS 5 normally searches every word in the database,
regardless of any field those words are in.  Fields may be used to limit a search to particular
groups and types of document.  This gives your searching more precision. 

When you search using an option from the Quick Search screen (see Section 6) you are often
running a field search, e.g. the Parties button performs a search on only the Parties field of a
database.

The sections on the Form Search screen (Section 7.1) and the General Search screen (Section
8.2) show you how you can use these fields to make your search more specific.  You will also
use fields when you use the Outline button (Section 11.1.4).

5.3 Indexes

Each field has an index of all of the words it contains, and you can view this index and select
terms from it to include in your query.  Selecting words from an index can be more precise
than using wild cards (see Section 5.1.2), because you can be sure that you are not including
any irrelevant words.  The index includes a frequency count for each word, so that you can
assess the importance of each word (see Sections 7.3 and 8.3).
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6. Quick Search Screen

After selecting a database (see Section 4) you are presented with the Search screen.  Here you
can select one of three search options: Quick, Form or General searching.  The first of these,
and the one you are normally presented with, is Quick Search.

As the name suggests, this screen is designed to allow quick and relatively simple searching on
a selection of the most useful fields in your selected database(s).  You can use search operators
when performing some quick searches, but you will only be searching in one field of the
database, as indicated by the name of the Quick Search button e.g. Document Number,
Parties or Title.

6.1 Quick Search Buttons

By clicking the buttons on the Quick Search screen, you bring up a dialog box where you can
enter your search term(s).  Each time you type a search term and click the adjacent Search
button, JUSTIS 5 carries out a search in the relevant field of your selected database(s).

6.1.1 Different Buttons with Different Databases

The fields in databases vary depending on the type of information in the database.  Not all of
the JUSTIS 5 databases share common fields and so the Quick Search buttons vary
depending upon which database(s) you select.

For example, if you select The Law Reports, Industrial Cases Reports or Weekly Law Reports,
you are offered the choice of Parties, Catchwords, Publication Reference or J-Link (as these
three databases are all case reporting series they share common fields).  If you select UK
Statutes, you are offered the choice of Title, Reference or J-Link.

NOTE:  If you have selected multiple databases that do not use
compatible fields, you will not be able to use the Quick Search
screen.  Instead you will be presented with the General Search screen
only (see Section 8).
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6.2 Performing a Quick Search

To search using a quick searching option:

1) From the Search screen, click the Quick Search button you wish to use.

2) Type the word, phrase or reference you wish to search for.  If your phrase contains
operators, surround it with quotation marks (see Section 5.1.4 for more details).  Proper
nouns do not need an initial upper case letter; the software is not case sensitive.

3) Click the adjacent Search button.

JUSTIS 5 tells you how many documents it has found (i.e. the number of hits) in the Search
message box.

• Click Yes to view the profiles of these documents on the Profiles screen (see Section
9).  If you have searched multiple databases, the profiles from each database will be
grouped together.

• Click No to refine your search query and run another search.

You can reverse the default order of display (for most databases this is chronological order) by
clicking the Show results in reverse order check box.

• To view the whole document for one of the profiles, double-click the profile.

• To return to the Quick Search screen, click the Query button on the toolbar.

If no documents are found that match your search query, you are presented with the following
message box:

6.2.1 Publication Reference Button

The Publication Reference button in case law databases is useful for finding a specific
document.  Type the reference, click the Search button, and JUSTIS 5 will locate the
document.

You do not need to include all the punctuation when you enter the reference.  For example,
the case reference 1946 ac 278 is found just as easily as [1946] A.C. 278.  However, you cannot
use operators or wild cards as you can with the other options - you must enter one complete
reference.  If you do not know the complete reference, you will have to use the Form Search
screen (see Section 7).

6.2.2 Re-Using a Query

JUSTIS 5 keeps a record of all the searches (also known as search queries) you use.  This can
be useful if you wish to use a query again.
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To re-use a search query:

1) Click the Quick Search button you wish to use.

2) Click the down arrow next to the text box.

3) Select a search from the list.

4) Modify the search if necessary, and then click the Search button.

This record of searches is separate from the Query History used for searches from the Form
Search and General Search screens (see Sections 7.5 and 8.4).

6.3 J-Link Button

The J-Link button is present on the Quick Search screen for all of the databases, and
allows you to search for documents in any of the available JUSTIS 5 products, even
if the databases have not been selected.

Type in a publication reference, a document number or the colloquial term for a document,
and then click the adjacent Search button.  JUSTIS 5 will analyse your request, decide which
database to access, and (if successful) display a list of the matching documents on the Profiles
screen.  If only one document matches your request, it will be displayed on the Document
screen.  If the required database is not accessible on your computer system, you will be
prompted to insert the CD-ROM.

The recognised colloquial terms include the names of European laws and treaties, for example
Maastricht Treaty, First Banking Directive and Trade Mark Directive.  You can use these terms
instead of trying to remember a publication reference.  For a list of the recognised terms, look
up Colloquial terms in the on-screen Help.
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7. Form Search Screen

The Form Search option is a way of undertaking more advanced searches on a database than
are possible using the Quick Search buttons.  It is accessed from the Query screen by clicking
the Form tab.  The Form Search screen comprises a series of text boxes in which you can enter
your search queries.  Each text box represents a field, apart from the last text box which is for
free text searching and allows you to search for words or phrases anywhere within a
document.

7.1 More About Fields

Fields can be used to limit a search to particular parts of documents and can make your search
more precise.

Form Search allows you to search for terms in a number of fields within a document, in
contrast to the simple searches on the Quick Search screen where you search in one specified
field.

Each product, and often individual databases within a product, has different fields associated
with it.

To see a list of all the fields for a database that are not already shown on the Form:

1) In the Query screen, click the Form tab to go to the Form Search screen.

2) Click one of the field name buttons and the Field Selection dialog box will open;
click the All Fields tab to display all of the fields in that database that are not in use
on the form.  If you have more than one database open, the Common Fields tab will
show you the fields that are common to all of the selected databases and that are not
in use on the form; the All Fields tab includes these fields and shows them in bold.

NOTE:  If you have selected multiple databases that do not use
compatible fields, you will not be able to use the Form Search
screen.  Instead you will be presented with the General Search screen
only (see Section 8).
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For example:

You can choose to search in one field only, or in a combination of fields.  All of the search
operators are applicable, as is the use of parentheses to specify logic, and the use of quotation
marks when your phrase contains an operator.  (See Section 5 for more details of these techniques.)

The operators to the left of the fields may be toggled between and, or or not by clicking on
the operator button.

7.1.1 Changing the Field Selection

For each database, there is a default selection of fields in the Form Search screen.  If you wish
to search in a field that is not one of the displayed fields, you can change a field that you do
not need:

1) On the Form Search screen, click the field button you wish to change (any of the
buttons that carry a field name and a black down arrow).

2) In the Field Selection dialog box, click the new field or group you wish to select and
then click OK.  The name of the new field will be displayed on the field button.

If you select fields that are not common to all of the databases you are searching, then your
results will be limited to only those databases where the field occurs.

7.1.2 Selecting Field Groups

The “All Fields” and “Common Fields” tabs in the Field Selection window displays field names
either in one list or in a series of columns, depending on your chosen databases.  Where there
is a series of columns, each will be headed by a group name in a yellow box.  By selecting the
group name, you can search all of the fields in the column.  For example, by selecting the OJ
group name in the Legislation database of CELEX you will search the ABSTRACT, DESCRIPT,
TEXT and CORRIG fields.

7.1.3 Searching Using a Combination of Fields

Once you have selected the desired combination of fields you can perform a search.  Type the
words or phrases you wish to search for (including any search operators) in the appropriate
fields.  You do not need to enter a search term in every field.

Example 1

In The Law Reports, type the following queries into the fields indicated.

PARTIES: financ* or invest*
CATCHWORDS: arbitration
COURT: queen’s

Click the Search button on the toolbar.
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The above search will look for cases in the Queen’s Bench Division, where the names of the
parties include any words that start with financ or invest and the Catchwords section includes
the word arbitration.  Other fields will be ignored.

Example 2

In the Legislation database of CELEX, enter the following queries into the fields
indicated, and then click the Search button on the toolbar.

TITLE: health not workplace
FORM: decision

The above search will look for Decisions in which the title includes the word health but not
the word workplace.

7.1.4 Free Text Searching

You may wish to search for terms throughout an entire document; this is called free text
searching.  The last text box on the Form Search screen is for free text searching. 

This method of searching is broader than searching for a term in a field, as JUSTIS will find
any occurrence of the search term anywhere within a document.  It will generally produce
more hits than field searching, but is often a good starting point before trying a more specific
search.

Example

In Weekly Law Reports, type the following search query in the Free Text box of the
Form Search screen, and then click the Search button on the toolbar.

FREE TEXT: race within 10 of discrimination

This search will find any document where the word race appears within 10 characters of the
word discrimination, either before or after it.

As with searching fields, you can include any search operators in your search query.

7.2 Executing your Search

After entering your search terms and operators in the appropriate fields, click the
Search button on the toolbar.  The Search message box will display the number of
hits your search has found.

• Click Yes to view the profiles.

• Click No to return to the Form to refine your search.  Use the Clear All button on the
toolbar to start a new search.

7.3 Word Index

Each field has an Index, which can be accessed by clicking the first of the buttons to the right
of the text box.  The index contains all of the words that appear in that field, and gives an
indication of the number of times that a word occurs.  You can select search terms from the
indexes to ensure that your search query includes all the possible variants of your search term,
including any alternative spellings.  You can also see when the * wild card would result in
further words that you do not want.
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The Word Index window shows the name of the field associated with the index.  There is also
a text box to enter a word root.  A word root can be all or part of a word, but must not include
a wild card.  The index will display all those words in the field that start with the letters you
entered.  A short word root, such as a single letter, will supply a long list of words, while a
longer root will narrow down the number of words shown in the list.

1) On the Form Search screen, click the Index button associated with a field.

2) Type the root of the word you wish to search for in the Word Root text box, and then
click the Browse button.  Do not use wild cards.

3) Click the word you require from the Word List window, and then click OK.  Your
selected word will be added to the text box for the field you have chosen.

The number to the left of the word in the index shows the number of times it appears in that
field.

To transfer a range of words to the field text box:

1) Click each word you require from the Word List window, while holding down the
Ctrl key on your keyboard.

2) Click OK.

This is particularly useful when several spelling alternatives are shown for what is clearly a
single topic.  If you transfer a range of words from the index in this manner, JUSTIS 5 will
automatically add the OR operator between the terms in the text box for the field.  This means
that JUSTIS 5 will look for documents containing any of the words selected from the index,
for example:

access OR accessible OR accessibility OR accessing

7.4 User Defined Dictionary

For each field there is a User Defined Dictionary that enables you to build a list of your
frequently used words and phrases.  Some products already have pre-loaded entries in the
dictionary, for example the Court field in The Law Reports and some of the other case law
products.

The Dictionary button has a book symbol on it, and is to the right of the fields.

• Click the Dictionary button to bring up the User Defined Dictionary
window, showing any existing terms for that field.
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To insert a word or phrase from the User Defined Dictionary into a field:

1) Select the appropriate dictionary for a field.
2) Click the word or phrase you wish to insert.
3) Click OK.

The selected word or phrase will automatically appear in the text box for that field.

To add an entry to the user defined dictionary:

1) Click the Add button to bring up the Editing Phrase window, and type the word or
phrase you wish to add.

2) Click OK.

JUSTIS 5 will insert the new entry into the dictionary, in alphabetical order.

In the User Defined Dictionary window you can edit entries, delete selected entries or delete
all entries, using the Edit, Delete and Delete All buttons.

You can import dictionary terms from a text file using the Import button.

7.5 Form Search Query History

As you run searches, a copy of each one is kept in the Query History.  This forms a library of
searches that you have carried out in JUSTIS 5 and displays details of the search terms and
fields searched, the session name, the database searched and the number of hits the search
produced.

To view the Query History:

• Click the Queries button on the toolbar to open the Query History:

You can re-run searches from the Query History on the currently selected database(s):

1) Click the search query you wish to re-run, to highlight it.
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2) Click the Replace button, to replace any existing search query with the one you have
chosen.

3) Click the Search button on the toolbar.

To see the full details of a search query:

1) Click a search query to highlight it.

2) Click the Details button.

The Query Details window will display the date of the query, the number of hits, the
database(s) the query was performed on and the full text of the query including fields.

To add a note to a search query:

1) Click the query you wish to annotate, to highlight it.

2) Click the Note button.

3) Type your note in the Query Note dialog box.

4) Click OK.

A yellow note marker will appear to the left of the query in the Query History window.  To
view or edit a note, repeat this process.

You can manage the list of queries in various ways:

• To remove selected search queries or all search queries, click the Delete or Delete All
buttons.

• To remove a note, click the Note button and then click the Remove button in the
Query Note dialog box.

You can choose which columns to display, and in which order they appear:

• Click the Columns button to choose which of the six possible columns you wish to
display, and their order left to right.

• Click the Ascending Order check box to list queries with the oldest query shown first
(the default order is with the most recent query first).

You can show or suppress items in the history:

• Click the Filter button to restrict the queries that are displayed to those that meet
certain criteria, such as session code, database, date range, or words from the query or
query note.

If you select Save program state on exit in Admin Preferences (see Section 15.2.8), JUSTIS 5
will remember the columns, order and filters that you have selected.

The Query History stores searches carried out on the Form Search and General Search screens;
it does not store searches from the Quick Search screen.

You can lock the History, so that new searches are not added, and you can choose whether to
keep the History between sessions; see Section 15.2.6.
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8. General Search Screen

The General Search screen offers a way of performing both quick and complex searches.  You
can include more fields in your search query than are represented on the Form Search screen,
and you can set up more complex queries than are possible on the Form Search screen.  To
view the General Search screen, click the General tab on the Query screen.

8.1 Entering a General Search

To perform a free text search, i.e. to look for your search term anywhere within a document:

1) In the General Search screen, type a search term in the Query text box, for example
try any of the following:

pollution
Trade Descriptions Act
personal near injury

2) Click the Search button on the toolbar to initiate the search.

The Search message box displays the number of hits your search has found.

• Click Yes to view the profiles.

• Click No to return to General Search to refine your search.  Use the Clear All button
on the toolbar to start a new search.

8.2 Including Fields
When you enter a search query in the text box on the General Search screen without
specifying a field, JUSTIS 5 will search for the words in the selected database(s), regardless of
the field that they might be in.  Limiting your search to particular fields gives your search
more precision.  (If you have selected databases that do not use compatible fields, then you
will not be able to use fields or the Fields button.)

1) To see the fields available, click the Fields button on the General Search screen.  A list
of fields will be displayed in the Field Selection dialog box.  You can get Help on a
field by clicking it and then pressing the F1 key on your keyboard.

2) To search in a specific field, either double-click the field name or click the field name
and then click OK.

3) The name of the field will be displayed in the text box and the cursor will be
positioned inside the square brackets immediately after the name.
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4) Type simple or complex queries inside the square brackets, for example try one of the
following:
TITLE[insurance or assurance]
DOCNUM[370L0220]
SUB[agriculture not (beef or meat)]

5) If you wish to search for further terms, but not within that particular field, move the
cursor outside the brackets and add the additional terms, for example:
GROUP[PQ] and income tax*
FORM[directive] and (meat near health)
HEADNOTE[mens rae] and (manslaughter or murder)

6) It is possible to search in more than one field at a time, for example:
TITLE[dairy or milk] and FORM[directive]

When searching products or databases that share common fields (e.g. Weekly Law Reports and
Family Law Reports, or CELEX Legislation and Proposals), the Field Selection dialog box
displays the fields for all of the selected databases.  Fields that are common to all of the
selected databases appear on the Common Fields tab.  A complete list of fields appears on the
All Fields tab, with common fields shown in bold.  If you select fields that are not common
to all of the databases that you have selected, then your results will be limited to only that
database where the field occurs.

8.3 Word Index

As with the Form Search screen, there is an Index feature.  This allows you to view an
alphabetical list of words that occur within either the whole of the database(s) that you are
searching, or in certain fields of the databases.

1) Click the Index button on the General Search screen to display the Word Index
dialog box.

2) Initially, the word “None” appears against Field, so that the complete index for the
database(s) will be used.  If you want to select the index for one field, click the Field
button, click one of the displayed fields from the Field Selection dialog box, and
then click OK.

3) Type in your selection in the Word Root text box (do not include wild cards) and
then click OK.  A list of words starting with the word root you entered is displayed in
the Word List text box.

4) Select the word you wish to be entered in the Query text box and then click OK.  You
can select more than one word by clicking them while holding down the Ctrl key on
your keyboard.
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The name of the selected field together with the index entry will be entered into the Query
text box.

8.4 General Search Query History

As you run searches, a copy of each one is kept in the Query History.  This forms a library of
searches that you have carried out in JUSTIS 5 and displays details of the search terms and
fields searched, the session name, the database(s) searched and the number of hits the search
produced.

To view the Query History:

• Click the Queries button on the toolbar.

You can re-run searches from the Query History on the currently selected database(s):

1) Click the search query you wish to re-run, to highlight it.

2) Click the Replace button, to replace any existing search query with the one you have
chosen, or click the Append button to add your chosen query to the end of the one
on the General screen.

3) Click the Search button on the toolbar.

To see the full details of a search query:

1) Click a query to highlight it.

2) Click the Details button.

The Query Details window will display the date of the query, the number of hits, the
database(s) the query was performed on and the full text of the query including fields.

To add a note to a search query:

1) Click the query you wish to annotate, to highlight it.

2) Click the Note button.

3) Type your note in the Query Note dialog box, and then click OK.

A yellow note marker will appear to the left of the query in the Query History window.  To
view or edit a note, repeat this process.

You can manage the list of queries in various ways:

• To remove selected search queries or all search queries, click the Delete or Delete All
button.

• To remove a note, click the Note button and then click the Remove button in the
Query Note dialog box.
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You can choose which columns to display, and in which order they appear:

• Click the Columns button to choose which of the six possible columns you wish to
display, and their order left to right.

• Click the Ascending Order check box to list queries with the oldest query shown first
(the default order is with the most recent query first).

You can show or suppress items in the history:

• Click the Filter button to restrict the queries that are displayed to those that meet
certain criteria, such as session code, database, date range, or words from the query or
query note.

If you select Save program state on exit in Admin Preferences (see Section 15.2.8), JUSTIS 5
will remember the columns, order and filters that you have selected.

The Query History stores searches carried out on the General Search and Form Search screens;
it does not store searches from the Quick Search screen.

You can lock the History, so that new searches are not added, and you can choose whether to
keep the History between sessions; see Section 14.2.6.
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9. Contents Screen

The third tab on the Search screen allows you to browse the records in a database and select
the records you wish to view.

The Contents screen allows you to locate records in a database by browsing through an
expandable hierarchical display of up to three levels.  This is a convenient way of looking at
the most recent records, or looking for documents of a particular type.  To see the Contents
screen, click the Contents tab on the Search screen.  If you have selected multiple databases
and they do not use compatible fields, then the Contents tab will not be visible and you can
only use a General Search to find documents.

When you select a database and then open the Contents screen, you will see only the top level
of the hierarchy (this is often a list of years), with profiles displayed for the first item.  To
expand the hierarchy so that you can see other levels and select a profile:

1) Click a plus sign (or double-click a term) to see the next level.

2) When you get to the terms at the lowest level (i.e. ones that do not have either plus
or minus signs), click a term to display a scrollable list of profiles in the right-hand
pane.  If you click on a term that is not at the lowest level, you will not see a list of
profiles.

3) Scroll through the list of profiles, and double-click one to display the full text on the
Document screen.

While using the Contents screen you can

• Click a minus sign (or double-click the adjacent term) to show fewer levels.

• Add notes to a document by clicking in the N column to the left of a profile, in
exactly the same way as adding a note from the Profiles screen.

• Mark documents by clicking in the M column to the left of a profile, in exactly the
same way as marking a document on the Profiles screen.

9.1 Customising the Hierarchy

You can change the way in which the hierarchy is arranged.  Click the Hierarchy button to
see a list of the available categories.

• Move a category up or down either by dragging it with your mouse, or by clicking it
and then clicking the Up or Down button.

• Remove a category either by dragging from the Selected list to the Remaining list, or
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by clicking it and then clicking the Remove button.

• Return a category to the Selected list either by dragging it with your mouse, or by
clicking it and then clicking the Add button.

• Click OK when you have arranged the categories as you want them.  If you decide not
to make any changes, then click the Cancel button.

If you select Save program state on exit in Admin Preferences (see Section 15.2.8), JUSTIS 5
will remember the way in which you have arranged the hierarchy.
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10. Profiles Screen

After you have completed a search query, be it a Quick, Form or General search, you are
presented with the Search tab of the Profiles screen.  If you have used a link (see Section 12),
you will see the Links tab.  Profiles usually consist of the document’s number or publication
reference, title, heading or case name, and a few keywords or catchwords that relate to the
content of the document.  (If your search found only one document, it will be displayed on
the Document screen; click the Profiles button on the toolbar if you want to see the profile.)

10.1 Viewing Profiles

Profiles are a good way to identify the most relevant retrieved documents, and normally
display the most recent document first.  You can display profiles in reverse order by clicking
the Display in reverse order check box in the Search message box which displays the
number of hits your search has found.

If you have searched more than one database, the profiles from each database will be grouped
together.

You can return to the Search screen at any time by clicking the Query button on
the toolbar.

The Document button will remain greyed out (not active) until a document has been opened.

You can move through the list of profiles if the list is too long to fit on the Profiles screen:

• Click the arrows at the ends of the scroll bar to move slowly through the list.

• Or move the scroll box by pointing and keeping the mouse button depressed, and
then dragging the box up or down to move quickly through the list.

• Or use the PgUp, PgDn or arrow keys on your keyboard.

To select a profile so that you can mark it (see Section 14.1) or add a note (see Section 13):

• Click once on a profile in the list.  The document profile will then appear as white
text on a black background.

10.1.1 Number of Hits and Pages

There are sets of numbers at the bottom of the Profiles screen.  The Hit numbers display which
hit number is selected and the total number of hits your search query has found.  The Pages
or Lines number shows the number of pages or lines in the highlighted profile.
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10.2 Viewing documents

After reviewing the profiles, double-click one in order to view the whole document on the
Document screen (see Section 11).

10.3 Printing

From the Profiles screen you can print either the profiles or the text of the documents.  If
you want to print the text of more than one document, then it is quicker to do so from this
screen; you can only print one document at a time from the Document screen.

If you want to print only one profile or its text:

1a) Click once on the relevant profile.

To select several profiles for printing:

1b) While holding down the Ctrl key on your keyboard, click on the profiles to be
selected.

Then:

2) Click the File menu at the top of the screen.

3) Click Print... to display the Print dialog box:

The Print Range options give you a choice of:

All Profiles - prints the profiles for all of the documents resulting from your search.

Selected Profiles - prints the profiles that you have selected.

All Documents - prints the text of every document listed on the Profiles screen.  Please
note that, depending on the number of hits and the length of the documents
involved, this process may take a very long time.

Selected Documents - prints the text of every document you have selected.

If you choose to print all or selected documents, then you can set a filter to print only
the fields that you want, by clicking to check the Print Selected Fields box and then
clicking Set Filter to open the Field Selection dialog box:
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If you have selected more than one database, you will be prompted to select a
database before you can set a field filter.  You can set a different field filter for each
database.

To see on-screen Help for the fields you are selecting, click a field and then press the
F1 key on your keyboard.  Select all the fields you require, and then click OK.

4) After selecting the options you require, click OK to send your records to the printer.

If you select Save program state on exit in Admin Preferences (see Section 15.2.8), JUSTIS 5
will remember the options that you have selected.

10.3.1 Printing complete Acts of Parliament

When you print documents from the Profiles screen, there is a “Join Documents” option.

This feature is designed for use with the UK Statutes database, and allows a complete Act of
Parliament (or selected sections or schedules) to be printed as though it was a single
document.

It is also useful for printing one or a few fields from each of several documents in many other
databases.

To retrieve all of the documents that constitute an Act, either select the Act on the Contents
Screen, or search for its title in the Title field on the Form Search screen.
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10.4 Exporting
From the Profiles screen you can export profiles to ASCII files and documents to ASCII or
RTF files.  If you wish to export the text of more than one document, then it is quicker to do
so from this screen; you can only export one document at a time from the Document screen.

If you wish to export only one profile or its text:

1a) Click once on the relevant profile.

To select several profiles for exporting:

1b) While holding down the Ctrl key on your keyboard, click on the profiles to be
selected.

Then:

2) Click the File menu at the top of the screen.

3) Click Export... to display the Exporting Profiles dialog box:

The Export Range options give you a choice of:

All Profiles - exports the profiles for all of the documents resulting from your search.
Selected Profiles - exports the profiles that you have selected.
All Documents - exports the text of every document listed on the Profiles screen.
Selected Documents - exports the text of every document you have selected.

If you choose to export all or selected documents, then you can set a filter to export
only the fields that you want.

If you have selected more than one database, you will be prompted to select a
database before you can set a field filter.  You can set a different field filter for each
database.

To see on-screen Help for the fields you are selecting, click a field and then press the
F1 key on your keyboard.  Select all the fields you require, and then click OK.
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If you want the exported documents to retain the layout displayed on screen, click the
Retain Carriage Returns option.  If you want the document to format normally in a
word processor, do not click this option.

4) Click OK to bring up the Save As dialog box.

5) Enter the file name, and select a drive and directory to export the document to.  By
default, the file is saved in the TEMP directory on your hard disk, e.g. c:\temp or
c:\windows\temp.  The system administrator can set a fixed export directory (see
Section 15.2.1).

If you want to save one or more documents as RTF files, type a file name (including a
.rtf extension), click the black down arrow opposite Save as type, and click Rich Text
Format (*.rtf).

6) Click Save.

JUSTIS 5 will now save the exported records, either as a plain text file (.txt), or as a Rich Text
Format (.rtf) file complete with formatting and ready for use in your word processor.

If you select Save program state on exit in Admin Preferences (see Section 15.2.8), JUSTIS 5
will remember the options that you have selected.

The default number of whole documents that can be exported in a session is 50.  The system
administrator can change this limit to any number from 1 to 500 (see Section 15.2.2).

10.5 Indicators

At the left of the Profiles screen, there are 3 columns of indicators.

The first column, marked “N”, allows you to view or edit a note; see Section 13.

The second column, marked “M”, allows you to mark or unmark a document; see Section 14.1.

The third column, marked “S”, shows the status of a document.  When viewing the results of
a search in the UK Statutes database, you can tell which Acts, sections and schedules have
been repealed because there will be a large red “R” next to them.
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11. Document Screen

After performing a search on the Query screen (see Section 6) and viewing the profiles of your
results (hits) on the Profiles screen (see Section 10), you can view the full document on the
Document screen.

• On the Profiles screen, either double-click a document profile, or click it once to select
it and then press the Enter key on your keyboard.

The Document screen will appear showing the text of your selected document:

11.1 Navigating Within a Document

There are various ways of navigating around a document when viewing it in the Document
screen.  The tools used are the four buttons with arrows located on the Navigation Bar at the
bottom of the Document screen, the scroll bar on the right of the Document screen and the
Outline button on the toolbar.

11.1.1 Page Button and Scroll Bar

You can scroll through the document page by page by using the arrows on either side of the
Page button at the bottom of the Document screen.  If you click the Page button itself, the
Go to Page window is displayed.

The numbers on either side of the scroll bar indicate the page range of the current document.
For documents from databases that are the electronic equivalent of printed publications, for
example the Weekly Law Reports, the page numbers are the same as those in the original
publication.  You can move to different pages in a number of different ways:

• In the text box, type the page number you wish to view (it must be within the
displayed range) and then click Go to.
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• Or click the arrows at either end of the scroll bar to increase or decrease the page
number in the text box, and then click Go to.

• Or click on the scroll box in the scroll bar, then hold down your mouse button and
drag the scroll box to change the page number displayed in the text box.  Click Go to
to open the displayed page number.

Alternatively, you can use the scroll bar at the right side of the screen:

• Click the single arrows to move up and down within the document
a few lines at a time.

• Or click the double arrows at the bottom right of the document
window to move through the document one page at a time.

• Or click and drag the scroll box in the scroll bar with your mouse; release the mouse
button when the required page number is displayed in the small yellow box alongside
the scroll bar.

• At the top of the scroll bar is a Top of page button.  Click this to return to the
top of your current page.  This is especially useful for databases where each
page has two columns.

Should you need to adjust the document horizontally, use the horizontal scroll bar at the
bottom of the document screen in the same way as the vertical scroll bar.

11.1.2 Finding the Search Term

The Term button enables you to jump quickly to each occurrence of any of the terms used in
your search query.  This becomes more important when you are looking for words that do not
appear at the top of the document.

• Click the right or left arrow of the Term button until you find a term.

The Term feature will only locate search terms within the field(s) upon which you performed
your search.  For example, if you searched for liability in the Catchwords field of a case report,
the Term facility will find only those instances of the word liability that appear in the
Catchwords.  Consequently all other occurrences of the search term do not appear in blue.  A
free text search for a word or phrase will result in every occurrence of the search term being
located by the Term facility and appearing in blue throughout the document.

• Click the word Term rather than on the arrows to open a window showing your
search terms.  This is just a reminder; you cannot edit the query.

11.1.3 Finding a Word

You can search the current document for words that you did not use in your search query:

1) Click the Find button to open the Find Dialog:

2) In the Find What text box, type the word or text string to be found, and indicate
whether the whole word should be matched, whether the case should be matched,
and in which direction to search through the document.  You cannot use wild cards
or operators.
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3) Click OK to find the word you have entered.

You can click the down arrow to the right of the text box to display a list of previous words
or phrases you have entered.  Once a part-word, word or phrase has been found, you can use
the left and right arrows to either side of the Find button to look for further occurrences.

The Cancel button will close the Find Dialog window.

11.1.4 Outline

If you wish to move quickly to a specific part of a document, such as the Headnote of a case
report or the Modified field for the Legislation database in CELEX, then you can use the
Outline button on the toolbar.  The Outline lists only those fields that are present in the
document, not all those that are used in the database. 

1) Click the Outline button on the toolbar to bring up the Outline:

2) Click the field you wish to jump to, and that part of the document will be displayed.
Alternatively, use the arrow keys on your keyboard to move up or down the list.

You can close the Outline, or move it to one side to use again by clicking and dragging its title
bar.  You can leave the Outline open while using the scroll bars or the buttons on the
Navigation Bar.

If you select Save program state on exit in Admin Preferences (see Section 15.2.8), JUSTIS 5
will remember the position and size of the Outline.

11.1.5 Navigating Using the Right Mouse Button

Clicking with the right mouse button while the cursor is over text in the Document screen
will display a pop-up menu.  You can use this menu to perform many of the functions of the
menu and toolbar, e.g. find a word, mark a document or enlarge the text of a document.
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11.2 Viewing the Next Hit

After viewing a document on the Document screen, you may want to view the next hit from
the list of profiles.  To do this you do not have to go back to the Profiles screen.

• Click the right arrow beside the Hit button near the bottom of the screen to go to the
next hit in the list of profiles, or click the left arrow to look at the previous hit.

The left and right arrows become greyed out and inoperable if you are at the beginning or end
of the profile list, or if there is only one hit.

To select a specific hit in the list of profiles:

1) Click the Hit button itself.

2) Click the left and right arrows at either end of the scroll bar to increase or decrease
the hit number (you can also enter a value yourself or slide the marker of the slide
bar).

3) Click the Go To button.

The document you selected will then be displayed on the Document screen.

11.3 Printing Documents
Once you have opened a document, you can print the whole document, selected pages, or a
block of text that you have selected with your mouse.

1) Click File on the menu bar, and select Print... to open the Document Print dialog
box.  (Alternatively press Ctrl+P on your keyboard.)

2) If necessary, change the printer by clicking the down arrow on the right of the printer
name text box and selecting an alternative.  To change the printer properties, click the
Properties button.

3) Select the Print range you wish to print by clicking All Pages, Current Page, Pages
or Selected Fields.  When you click Current Page, a text box appears telling you which
page is the current one.  If you select Pages, a text box will open in which you can
type the numbers of the pages you wish to print.  If you have selected text in the
document, JUSTIS 5 will offer you an extra option, Selection, which prints only your
selected text.

To print only the fields that you want, click to select the Selected Fields option and
then click the Fields button to open the Field Selection dialog box:
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To see on-screen Help for the fields you are selecting, click a field and then press the
F1 key on your keyboard.  Select all the fields you require, and then click OK.

4) Enter the number of copies you wish to print by using the arrows on the right of the
Number of copies text box, or alternatively type in the number of copies you
require.

5) If appropriate, click the check boxes for the options to print to file, collate copies, add
side letters, or remove any colour from links, search terms and text that you have
highlighted.

6) Click OK to print your document or part document.

If you select Save program state on exit in Admin Preferences (see Section 15.2.8), JUSTIS 5
will remember the options that you have selected.

11.4 Exporting Documents

Exporting a document allows you to save the text of the document as an ASCII or RTF file,
either to your hard disk or to a floppy disk.  You can print the whole document, selected pages,
or a block of text that you have selected with your mouse.

1) Click File on the menu bar, and select Export... to bring up the Exporting
Document dialog box.

2) Click the appropriate Export Range: Document, Pages or Selection.  If you click the
Pages option, you must then enter the numbers of the pages you wish to print.  By
default, JUSTIS 5 will enter the number of the current page in the Pages text box.

3) If you want to export only certain fields, click the Export Selected Fields option and
then click the Set Filter button to open the Field Selection dialog box where you
can choose the fields you want.  To see on-screen Help for a particular field, click it
and then press the F1 key on your keyboard.
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Select the fields you require, and then click OK.

4) If you want the exported document to retain the layout displayed on screen, click the
Retain Carriage Returns option.  If you want the document to format normally in
a word processor, do not click this option.

5) Click OK to bring up the Save As window.

6) Enter the file name, and select a drive and directory to export the document to.  By
default, the file will be saved in the TEMP directory on your hard disk, e.g. c:\temp or
c:\windows\temp.  The system administrator can set a fixed export directory (see
Section 14.2.1).

7) Enter the file name, and select a drive and directory to export the document to.  By
default, the file is saved in the TEMP directory on your hard disk, e.g. c:\temp or
c:\windows\temp.  The system administrator can set a fixed export directory (see
Section 14.2.1).

If you want to save the documents as an RTF file, type a file name (including a .rtf
extension), click the black down arrow opposite Save as type, and click Rich Text
Format (*.rtf).

8) Click Save.

JUSTIS 5 will now save the exported record, either as a plain text file (.txt), or as a Rich Text
Format (.rtf) file complete with formatting and ready for use in your word processor.

If you select Save program state on exit in Admin Preferences (see Section 15.2.8), JUSTIS 5
will remember the options that you have selected.

The default number of whole documents that can be exported in a session is 50.  The system
administrator can change this limit to any number from 1 to 500 (see Section 15.2.2).
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11.5 Copying and Pasting Text

Text from a document can be copied and pasted into another Windows application, such as a
word processor.

1) While holding down the left mouse button, slowly drag the mouse over a section of
text to select it.

2) Click Edit on the menu bar and then select Copy. (Alternatively, press Ctrl+C on
your keyboard.)

3) Switch to the appropriate Windows application, e.g. Word,  WordPerfect or WordPro.

4) Place the cursor where you wish the copied text to appear, click Edit on the menu bar,
and select Paste.  (Alternatively, press  Ctrl+V on your keyboard.)
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12. Linking and Cross Referencing

One of the most powerful features of JUSTIS 5 is the ability to link from the current document
to other documents to which reference is made, not only in the same database but in other
databases too.

If a link could take you to more than one document, profiles of the documents will be
displayed on the Links tab of the Profiles screen (see Section 10), so that you can choose which
document to view.

12.1 Hypertext Links in Case Reports

Hypertext links occur in the headnote of case reports e.g. Weekly Law Reports and Family Law
Reports.  They are references to other cases that are cited in the headnote of the case report
you are currently viewing.  They appear in red italics and when the cursor is placed over the
link it changes to a hand symbol containing ‘H’.

If you click the hypertext link, JUSTIS 5 will locate and open the referenced document,
provided that you subscribe to the database in which the document is located.  For example,
if in Family Law Reports you click a hypertext link to a case report in The Law Reports, JUSTIS
5 will open the referenced case report in The Law Reports.

To go to the Headnote section of a case report, use the Outline button (see Section 11.1.4) on
the toolbar and select Headnote.

Quite often a case cited in the Headnote of a case report includes references from a number of
different case reporting series.  For example:

Whitworth Street Estates (Manchester) Ltd. v. James Miller & Partners Ltd. [1970] A.C. 583; [1970]
2 W.L.R. 728; [1970] 1 All E.R. 796, H.L.(E.) 

Where there is a reference to more than one JUSTIS 5 product, you are presented with a list of
profiles on the Links tab of the Profiles screen (see Section 10).  Double-click a profile to display
the document.  You can choose which databases should be available for linking (see Section
15.1.1).

12.2 Case Names in Case Reports

In case report databases, cases referred to outside the Headnote appear in black italics or small
capitals.  Links to these references use a slightly different technology called J-Link.

In addition to J-Link, case names have been prepared so that when you pass the cursor over a
case reference outside of the Headnote, it changes to a hand symbol containing the letter ‘J’.

The method for linking to a case name is the same as linking to a red hypertext link.

1) Click the Outline button on the toolbar and select a field, e.g. Citation or
Judgment.

2) Move the cursor over a case reference to change it to the J hand symbol.
3) Click the case reference.

JUSTIS 5 will retrieve and display the full text of the case report.

If a match cannot be found, J-Link will give you an appropriate explanatory message.
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If you select a link to a case report in a database to which you subscribe but which is not in
your CD-ROM drive, and which has not been transferred to a local or networked hard disk,
you will be prompted to load the appropriate CD-ROM.

12.2.1 Linking from Footnotes

Sometimes, particularly in older case reports, cases are cited in a footnote that gives the
publication reference.  To link to a case reference in a footnote:

1) Hold down the left mouse button and drag over the footnote reference
number to select it.  For example, select [1953] 1 W.L.R. 1241.

2) Click the J-Link button on the toolbar.

The document will be displayed.

To view a footnote:

1) Move the cursor over the footnote reference number to change the cursor to a
hand symbol containing an ‘f’ indicating a footnote link.

2) Click the footnote reference number to display the Footnote dialog box containing
the publication reference of the cited case.

It is not possible to use the J-Link button with a reference in the Footnote dialog box.
However, you can select and copy the reference with your mouse, and then use the J-Link
button on the Quick Search screen (see Section 6.3).

12.3 Links to Page References in Case Reports

In addition to the links that refer to other cases, there are page references that refer to other
sections of the current case.  These are in green text, and the cursor changes to a hand symbol
containing a ‘P’ when placed over the reference.

1) Move the cursor over a green number so that it changes to a hand with a P.
2) Click on the green text to jump to the referenced page.

You will be taken directly to the referenced page and section of the current case report.

12.4 Linking to Non-Case Law Databases

J-Link also operates in JUSTIS 5 products other than case reports, but in a slightly different
way.

For example, you are looking at a directive in CELEX and the implementation measures list a
reference to a Statutory Instrument.  By using J-Link you can retrieve the full text of that SI,
assuming that you subscribe to the UK Statutory Instruments CD-ROM.

Examples of how the J-Link function can help you link between documents:

CELEX Proposal to resulting CELEX Directive
CELEX Directive to Statutory Instrument
CELEX Proposal to full text in Official Journal C
OJ C Proposal to Directive in CELEX
EC Reference to full text in CELEX

12.4.1 How to Use J-Link Within a Document

While viewing a document:

1) Drag the cursor with your mouse to select the reference you wish to find.  The
reference may be something like this:
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Commission Directive No. 77/80/EEC

or it may be expressed as:

The First Banking Directive

2) Click the J-Link button on the toolbar to link to the referenced document.

12.4.2 Unsuccessful or Ambiguous Links

Situations when J-Link will fail to automatically retrieve a document are listed below.  Where
J-Link does not take you immediately to the document you require, a message box will be
displayed informing you why the J-Link operation failed.

• J-Link recognises the reference but cannot find the document, perhaps because it is in
a database that is not in your CD drive and has not been transferred to a local or
networked hard disk.
The Database Manager dialog box is displayed.  This prompts you to load the
appropriate CD-ROM in the CD drive.  If you are accessing databases across a network,
click the Scan button and enter the location of the database on the network.

• The reference you have selected can be linked to more than one document.
For example, a case may have been recorded in The Law Reports, Family Law Reports
and Weekly Law Reports.  The profiles (including the document reference, the title
and the first three catchwords) of the documents that can be linked to from the
highlighted reference are displayed on the Links tab of the Profiles screen.  Select the
document you wish to link to, and press the Enter key on your keyboard.  (See also
Link Preferences in Sections 15.1.1 and 15.1.2.)

• J-Link does not recognise the text you have selected.
A message box appears telling you ‘No expression which can be treated as a link was
identified.’.  This could mean that you have not selected the whole of the reference.

• The document is not available.
A message box appears telling you ‘Link to publication reference could not be made.
(Could be unavailable series, or invalid year or volume number.)’.  This indicates that
the series is not available (e.g. All England Law Reports), or that the series is available
but not the particular year or volume number.

12.5 Cross Referencing

In the case reporting series, Crossref provides links to preceding and subsequent cases that
may have a bearing on the case you are currently viewing.  Preceding cases are cases cited in
the Headnote of your currently viewed case report.  Subsequent cases are those cases that cite
your currently viewed case in their Headnote.

In the statute law and European law series, Crossref provides links to preceding and
subsequent documents that amend, implement, are amended by or are implemented by the
current document.

While viewing a document:

1) Click the Crossref button on the toolbar to bring up the Cross
References dialog box.  (If the button is greyed out, there are no related
documents.)
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2a) In case law series, click the JJ-VViieeww, PPrreecceeddiinngg or SSuubbsseeqquueenntt tab to view the profiles
of relevant cases.

2b) In statute law and European law series, click the JJ-VViieeww, AAmmeennddss or AAmmeennddeedd BByy tab
to view the profiles of relevant documents.

3) Click a relevant profile, and then click the Go to button to display the referenced
case.

The J-View tab provides a graphical representation of both preceding and subsequent
documents.  The document that is open on the Document screen is indicated by an open book
with a yellow bookmark; its details are also shown in a text box near the top of the Cross
Reference dialog box.  You can navigate in this display without having to view the complete
documents.

• Point to a book or text (using your mouse) to see a popup with a few keywords
describing the content of the document.

• Click once on a book or text to make that document the central one in the display,
with its preceding and subsequent documents on either side.  The text for documents
that you have not viewed is blue; the text for viewed documents is purple.

• Click Show images to remove the tick if you want to hide the book icons so that you
can see more information.  This happens automatically if there is a very large number
of links.

• Double-click a book or text (or click once and then click the Go To button) to display
that document on the Document screen and close J-View.

You can use the navigation buttons to go back through the trail of documents; the left button
takes you back directly to the original document, and the right button takes you back one step
at a time.

When you open a document from J-View, it becomes the current document, but the document
that was previously displayed remains open; you can choose between open documents by
using the Window menu.

The Preceding, Subsequent, Amends and Amended By tabs provide the same information in a
text version.

If you select Save program state on exit in Admin Preferences (see Section 15.2.8), JUSTIS 5
will remember the position and size of the Cross References dialog box.

12.6 Document Trail and Go Back

During the course of your research you may wish to return to a previously opened document.
Even if you view, link to or search for other documents, a trail of every document viewed is
recorded throughout your current search session.  You can quickly return to the previously
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opened document, or you can select a document from a list of all those previously viewed
during the current session.

To return to the previously opened document:
• Click the document with the red arrow on the Go Back button on the

toolbar.  The previously opened document will be displayed.

To return to a document opened earlier in a session:
1) Click the down arrow on the Go Back button on the toolbar.

2) In the Trail of all the documents you have viewed, find the one you wish to return
to, and click it to select it.

3) Click the Go to button.

12.7 Searching from Within a Document

While reading a document, you may find a word or phrase that is particularly relevant.  If you
wish to search for other documents in the same database that contain the same phrase then
you can do this from within the document.

1) Drag with your mouse over a phrase within the text of a document to select it. 
2) Click the Search button on the toolbar, to open the Search dialog box:

The Search dialog box gives you the chance to modify the search term(s), and to limit
the search to a particular field; click the down arrow to select from a scrollable list of
fields.

3) Once you have refined your search as necessary, click the Search button.  A new list
of profiles (see Section 10) will be displayed.

Searches carried out in this way are recorded in the Query History (see Sections 7.5 and 8.4).

12.8 Floating J-Link

Floating J-Link utility is a small Windows application that you can leave running in the
background while you are using a database, a word processor, an encyclopaedia, a Web
browser, an electronic book, or almost any application or file that includes references to UK
or European Union legal or official documents that are included in one of the Justis databases.

NOTE:  When performing a search from within a document,
your previous list of profiles will be replaced by the new search
profiles.  You cannot return to your previous profiles list with-
out re-running your original search.
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An icon for the program is installed in the Context group on the Programs menu that appears
when you click the Start button.

All you have to do is select a reference and then click the big button in the Floating J-Link
icon.  It will then analyse the selected reference, and if it recognises something it will start
JUSTIS 5, locate the appropriate document in any of the available databases, and display it for
you. 

Floating J-Link utilises J-Link, a technology developed by Justis Publishing for recognising a
string of characters as a reference to a document, and then locating the document in one of
the Justis 5 databases and displaying it.  If more than one document matches the reference,
then a list of profiles is displayed.

Floating J-Link can only work with applications that allow text to be selected, using either the
keyboard or a mouse, and copied to the Windows Clipboard.  Applications that append extra
data (such as a copyright notice) to the copied text may not be suitable for use with the
floating J-Link icon.

When you use Floating J-Link to start JUSTIS 5, the normal start-up routine is by-passed and
a database is not selected.  Because of this, the Query button on the toolbar is greyed out and
cannot be used.  If you want to continue searching within JUSTIS 5, please select a database.

Floating J-Link can recognise case report references (not case names), CELEX document
numbers, EU Directives, EU Regulations, EU COM DOCS, common names of EU treaties and
some EU legislation, European Court case numbers, Statutory Instrument numbers, and Acts
of Parliament.
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13. Working with Notes

If you wish to annotate a particular document you can use the Note feature.  Notes can be
attached to a document and/or to individual pages of a document.  They do not become part
of the document, but they are retained until you delete them.

The system administrator can disable the Note function (see Section 15.2.3).

13.1 Adding a Document Note

13.1.1 Adding a Document Note from the Profiles Screen

To add a note that applies to a whole document, from the Profiles screen:

1) Select the profile to which you wish to add the document note by clicking it once.

2) Click the yellow note on the Note button on the toolbar.

3) In the Document Note window that appears, type your note.

4) Click OK.

A yellow note marker will appear alongside the profile of the document in the left-hand
column marked N.

Notes added to documents from the Profiles screen refer to the whole document.  To add a
note to a particular page, you need to open the document on the Document Screen.

13.1.2 Adding a Document Note from the Document Screen

To add a note that applies to the whole document while the document is open on the
Document screen:

1) Click the down arrow on the Note button on the toolbar (or select Note List on the
View menu) to open the Note List.

2) In the Note List dialog box, click the Add button (or double-click <Add Document
Note>) to open the Document Note dialog box.

3) Type in your note.

4) Click OK.

A yellow note marker will appear on the Navigation Bar near the bottom of the screen.
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13.2 Adding a Page Note

You can add notes to as many pages as you wish within a document, but only one note per
page, and only from the Document screen:

1) View the page to which you wish to add a note.

2) Click the yellow note on the Note button on the toolbar (or select Note on the Tools
menu).

3) In the Page Note dialog box, type your note and then click OK.

A yellow note marker will appear on the Navigation Bar near the bottom of the screen.

13.3 Viewing or Editing a Note

To view or edit a document note:

• On the Profiles screen, click the yellow note on the Note button on the
toolbar (or select Note on the Tools menu).

• On the Document screen, click the down arrow on the Note button on the toolbar
(or select Note List... on the View menu, or click the yellow note on the Navigation
Bar), and then select the Document note.

To view or edit the page note on the current page:

• Click the yellow note on the Note button on the toolbar.

To view or edit any page note from the Profiles or Document screen:

1) Open the Note List by clicking the down arrow on the Note button on the toolbar,
or select Note List... on the View menu.  (You can also click the yellow note to the left
of the profile.)

2) Click the note you wish to view or edit.

3) Click the Info button to open the note.

You can also view a document note using this procedure.

To open a document at the page to which a note is attached:

1) On the Note List, click the appropriate note.

2) Click the Go To... button.

13.4 Deleting a Note

To delete a document or page note from either the Profiles screen or the Document screen.

1) Click the down arrow on the Note button on the toolbar (or select Note List... on
the View menu) to open the Note List.

2) Click the note you wish to delete.

3) Click the Delete button to delete the note.

13.5 Information Stored with a Note

Notes not only carry the text that you have entered, but also detailed information about the
document to which the note is attached, the date the note was made, and (for page notes) the
appropriate page number.  To see information about the document:

1) Click the down arrow on the Note button on the toolbar (or select Note List... on
the View menu) to open the Note List.
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2) Click any note.

3) Click the Info button to open the note.

4) Click the Show Details >> button.

13.6 Searching for Notes

You can search for a Note that you have added to one or more documents, from either the
Profiles screen or the Document screen:

1) Click the down arrow on the Note button on the toolbar (or select Note List... on
the View menu) to open the Note List.

2) Click the Search button in the Note List (not the one on the toolbar) to open the
Note Search dialog box.

3) In the Find Text box, type a word or phrase you wish to search for amongst the notes
you have made, and click the adjacent Search button (not the one on the toolbar).
Please note that you cannot use search operators or wild cards.

4) The notes that contain the search term you entered in the Find Text box will be
displayed in the Results window.

5) Click one of the notes in the Results window, and then click the Go To… button to
open the document associated with that note.  JUSTIS 5 will locate the document
regardless of the database you are currently in, and prompt you to load the CD-ROM
if necessary.

JUSTIS 5 keeps a list of the searches that you perform on the Note Search screen, so that you
can re-use them at a later date:

1) Click the down arrow at the right hand side of the Find Text box.  A list of previous
note searches will appear:

2) Click a previous note search and it will automatically be inserted into the Find Text
box.

3) Click the Search button to re-run the note search.
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You can delete notes from the Note Search dialog box by clicking the Delete button; you then
have a choice of deleting the selected note, or all notes, or notes entered before a particular
date.

You can edit notes by clicking the Info button.  You can open a document at the page to
which the selected note is attached by clicking the Go To... button. 
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14. Marking and Highlighting Documents

14.1 Marking Documents

The Mark feature enables you to mark a document for future reference within your current
searching session.  The mark will be removed when you exit JUSTIS 5.  The marks take the
form of a red tick that is visible near the bottom of the Document screen and to the left of the
Profiles screen.

14.1.1 Marking Documents on the Profiles Screen

To mark a document from the Profiles screen and add it to the list of marked documents:

1) Click a document profile to select it.

2) Click the red tick on the Mark button on the toolbar.  Alternatively, click
in the column headed M, to the left of the profile.

A red tick will appear alongside the profile.  Repeat the same process to remove the mark.

14.1.2 Marking a Document on the Document Screen

To mark a document from the Document screen and add it to the list of marked documents:

• Click the red tick on the Mark button on the toolbar.

• Or select Mark/Unmark on the Tools menu.

A red tick will appear on the Navigation Bar near the bottom of the screen.  Unlike a Note, a
Mark is attached to the whole document rather than a single page.  Marks only remain
attached to a document during one session.  Once you exit JUSTIS 5, all marks created within
that session are erased.

14.1.3 List of Marked Documents

You can view a list of profiles of the documents that you have marked during your current
session, by clicking the down arrow on the Mark button on the toolbar.  Alternatively, select
Mark List... on the View menu.  This can be done from either the Profiles screen or the
Document screen.

The Mark List dialog box will be displayed:

From this dialog box you can:

• Print the documents in the Mark List by clicking the Print button.  This gives you options
to print either profiles or complete documents, and to print all records on the Mark List
or only those you select.  To select multiple records, hold down the Ctrl key on your
keyboard while you click them.  If you choose to print complete documents, you can set
a filter to print only the fields you require.
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• Delete a selected document from the Mark List, by clicking the Delete button, or delete
all documents from the Mark List by clicking the Delete All button.

• View a document on the Document screen, by selecting its profile in the Mark List and
then clicking the Go to >> button.

• Add the document you are currently viewing on the Document screen (or the one
highlighted on the Profiles screen) to the Mark List, by clicking the Add button.

14.2 Highlighting Text in Documents

You can highlight in colour any part of a document that is displayed on the Document screen,
so that you can easily spot relevant passages.  Highlights are attached to the documents and
stored, so that they are visible every time the document is viewed, in the current or future
sessions.

The system administrator can prevent all users from using highlighting (see Section 14.2.4).

14.2.1 Adding Highlighting

To highlight text, select Highlight from the Edit menu; the cursor will change to a hand
holding a marker pen.  Hold down your mouse button and drag it over the text you wish to
highlight.

If you have a colour printer, you can print the coloured highlights.  There is an option to
remove colour during printing.

14.2.2 Removing Highlighting

To erase a highlight, select Erase Highlight from the Edit menu; the cursor will change to the
shape of an eraser.  Click anywhere within a highlighted area to erase the highlight.

14.2.3 Selecting a Colour for Highlighting

You can choose the colour in which to highlight text.  Select Highlighter Colour from the
Edit menu, then click the colour that you want in the Color picker and click OK.  You can
define a custom colour if you wish.

Choosing a new colour does not change the colour of existing highlights, so you can use more
than one highlight colour within a document.
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15. Preferences

Some of the features and functionality of the JUSTIS 5 software can be controlled and
customised by the user.  This facility enables:

• System administrators to control the use of JUSTIS 5 databases in a networked/public
environment.

• End users to control the operation of the software based on the project in hand or
subscriptions to JUSTIS 5 products.

• End users to set personal preferences as to how the software should function.

To change preference settings:

• Select Tools from the menu bar, followed by Preferences.

This will display the Preferences dialog box.

It contains three tabs:

User These options can be set or changed by the end user at any time.

Admin These options are intended for the system administrator.  They can be password
protected if it is necessary to prevent end users from changing any of these
settings.

Databases These settings are intended for the system administrator.  They allow the
available Justis 5 products to be specified.  Products that are not marked as
available here cannot be selected, and links to records in these products will not
be available.

15.1 User Preferences

15.1.1 Enable/Disable Links

Some hypertext links result in more than one possible destination.  For example, if you are
viewing a case report in The Law Reports and click a citation, the case name may be followed
by references to that case in The Law Reports, Weekly Law Reports and Family Law Reports.
For example:

Besterman, decd., In re (1981) 3 F.L.R. 255; [1984] Ch. 458; [1984] 3 W.L.R. 280; [1984] 2 All E.R.
656, C.A.

If all three JUSTIS 5 products are available, JUSTIS 5 will display profiles of the three
documents on the Links tab of the Profiles screen, so that you can choose which document to
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display.  However, for a particular project you may wish to exclude one product from the list
as it may not be appropriate.  The section entitled Enable/Disable links can be used to
indicate the products and databases from which references are to be included in the lists.

In the above example, if you disable links to Weekly Law Reports, the link will result in the
display of only LR and FLR references.  The reference to WLR will not be displayed.

1) Click Tools on the menu bar, and then select Preferences.

2) On the User tab of the Preferences dialog box, click in the check boxes in the
Enable/Disable links section to add or remove a tick next to the products or
individual databases.  A tick enables links to that product or database.

Some databases are available in more than one language, and you can choose to enable or
disable links for each language version.

15.1.2 Combining LR and WLR

The cases in volumes 2 and 3 of the printed version of Weekly Law Reports are eventually
included in The Law Reports, with the addition of the argument.  Therefore, these cases will
appear twice in a search that combines The Law Reports and Weekly Law Reports databases.
This duplication can be avoided by excluding volumes 2 and 3 of WLR when these two
databases are combined.

1) Click Tools on the menu bar, and then select Preferences.

2) On the User tab of the Preferences dialog box, click on Exclude Weekly Law Reports
Vol. 2,3 when searching eLR and WLR together.

This will eliminate the duplication of cases in the results of a search on the combined The Law
Reports and Weekly Law Reports databases.

15.2 Admin Preferences

15.2.1 Export Directory

JUSTIS 5 documents and profiles can be exported as ASCII or RTF files (see Sections 10.4 and
11.4).  The system administrator can specify where these files should be kept, using the
Export Directory option.

1) Select Tools on the menu bar, followed by Preferences.

2) In the Preferences dialog box, click the Admin tab and enter the directory
destination in the Export Directory text box.

3) Click the button to the right of the text box to browse and select a directory if
necessary.

For example, the system administrator in a library may choose to force all exported files to be
saved on A:\, to avoid filling up the hard disk with users’ files.

NOTE:  If you exclude Weekly Law Reports Vol. 2 and 3 when
searching LR and WLR together, you will also not locate any
recent Vol. 2 and 3 cases not yet included in The Law Reports.

NOTE: If you have customised your CD-ROM menu
and marked some databases as unavailable, the links
will be automatically disabled (see Section 15.3).
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15.2.2 Export Limit

You can export documents from JUSTIS 5 not only from the Document screen but also from
the Profiles screen.  On the Profiles screen, you have the option of exporting just the profiles
displayed or the complete documents represented by the profiles.

Exporting the full documents from the Profiles screen could be very time consuming and
could require a large amount of hard disk space, especially if the number of hits involved is
high.  The system administrator can use the option Export Limit (Documents) to limit the
number of full documents exported in each session.

1) Click Tools on the menu bar, and then select Preferences.

2) In the Preferences dialog box, click the Admin tab.

3) In Export Limit (Documents), enter the maximum number of documents that you
wish to be downloaded in one session.

The default limit is 50 documents, and the system administrator can set a limit from 1 to 500.

15.2.3 Disable Notes

All the notes (see Section 13) which are attached to documents are kept until you delete them.
If the same environment is being used by more than one user (e.g. a stand-alone computer in
a library), it may not be desirable for one user’s notes to be available to other users.  In such
circumstances the option to disable notes can be used to prevent users from adding notes to
documents.

1) Click Tools on the menu bar, and then select Preferences.

2) In the Preferences dialog box, click the Admin tab.

3) Click Disable Notes in the Document Options section to produce a tick in the check
box.

15.2.4 Disable Highlighting

All the highlights (see Section 14.2) which are applied to documents are kept until you delete
them.  If the same environment is being used by more than one user (e.g. a stand-alone
computer in a library), it may not be desirable for one user’s highlighting to be visible to other
users.  In such circumstances the option to disable highlighting can be used to prevent users
from adding highlighting to documents.

1) Click Tools on the menu bar, and then select Preferences.

2) In the Preferences dialog box, click the Admin tab.

3) Click Disable Highlighting in the Document Options section to produce a tick in
the check box.

15.2.5 Password Protection

The above settings can be protected by a password in order to prevent other users from
changing them.

1) Click Tools on the menu bar, and then select Preferences.

2) In the Preferences dialog box, click the Admin tab.

3) Click Password protect admin settings to produce a tick in the check box.

4) If no password has been set, click the Set Password button and enter a new
password.

61

JUSTIS 5 USER MANUAL



If a password has been set, clicking the Admin tab will display a prompt for the password,
which must be entered correctly before the dialog box can be displayed.

15.2.6 Query History Options

The Query History (see Sections 7.5 and 8.4) keeps a record of the searches that you make on
the Form Search screen and the General Search screen.

The first option is “Update History”.  When this option is selected, new searches are added to
the History; this is the default.  When it is not selected, the History is frozen, and no new
searches are added.

The second option is “Delete History on exit”.  The default setting is not selected, so that the
History is kept when you exit JUSTIS 5.  If you do not want to keep the History, select this
option and the History will be deleted when you exit JUSTIS 5.

15.2.7 Miscellaneous Options

The only option in this group is “Group Selection Warning”.  In the Select Databases dialog
box (see Section 4.1), it is possible to select an entire group of databases (e.g. Case Law) to
search.  This will prompt you for the location of any databases to which you do not have
access.  Selecting this option makes a warning appear if you select an entire group.

15.2.8 Save Program State on Exit

When this option is selected, JUSTIS 5 will remember the settings that you have selected
during a session, so that they will still be in effect the next time you use the program.  The
settings that are remembered include:

• Selected databases (including none selected). (see Section 4.4)

• User preferences.

• Query History columns, filter and sort order. (see Sections 7.5 and 8.4)

• Contents Screen hierarchies (see Section 9.1)

• Print options such as Page Break After Each Document and Add Side Letter. (see
Sections 10.3 and 11.3)

• Export options such as Retain carriage returns. (see Sections 10.4 and 11.4)

• Position and size of the Outline (see Section 11.1.4), Query History and Cross
References (see Section 12.5) dialog boxes.

If you want to set up JUSTIS 5 so that it always starts with your preferred settings, but does not
remember changes made during a session:

1 Select ‘Save program state on exit’.

2 Adjust the various settings to suit your preferences.

3 Exit the program so that the settings are saved.

4 Start JUSTIS 5 and un-select ‘Save program state on exit’.

5 Exit the program.

Now when you start JUSTIS 5, make changes and exit the program, your preferred settings will
be retained.

62

JUSTIS 5 USER MANUAL



63

JUSTIS 5 USER MANUAL

If your computer is used by several users, and you do not want them to be able to change the
remembered settings, then the System Administrator can protect all of the settings on the
Admin tab with a password (see Section 15.2.5).

15.3 Databases Preferences

Clicking the Databases tab on the Preferences dialog box displays a list of all of the current
CD-ROM products and databases from Justis Publishing.  If you leave the settings as they were
when you first installed JUSTIS 5, you will be able to select any combination of databases and
products from the Select Databases dialog box (see Section 4).

In small organisations, everyone will probably know to which Justis Publishing products they
subscribe, so it is not necessary to alter the original settings.

However, in large organisations where many users do not know to which Justis Publishing
products they subscribe, confusion can arise when users find that they cannot search some
databases that are present in the list of available databases.

The settings on this tab allow a system administrator to mark the databases to which their
organisation subscribes.  Once this has been done, the marked databases will be indicated by
a tick in the Select Databases dialog box, and it is not possible for users to select any other
databases.
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16. On-Screen Help

The JUSTIS 5 software includes an extensive on-screen Help system that is available from
almost any point in the program and that usually provides Help relevant to the feature or
function you are using.

The Contents for the Help system is available by selecting Contents & Index on the Help
menu to display the 3-tab Help Topics.  If it is not already on top, click the Contents tab.

The Contents tab displays a collapsible outline of the JUSTIS 5 Help files that are installed on
your computer.  Double-click a closed book to expand its contents.  Double-click an open book
to close it.  Double-click a page with a question mark to display that topic.

The Index tab displays, and allows you to search for, the predefined index terms in all of the
installed JUSTIS 5 Help files.

The Find tab allows you to carry out a free text search on any word(s) in the text of any or all
of the installed JUSTIS 5 Help files.  The first time you use it, an index needs to be created on
your hard disk, and this can take a few minutes.  Depending on the options you choose, the
index can be as large as 4Mb.

For detailed instructions on using Help, click Using Help on the Help menu, to see Microsoft’s
instructions on Help.

16.1 Help on Databases

While you are using the Select Database(s) dialog box (see Section 4), you can get Help on any
database or product (even if you do not subscribe to it) by clicking it and then pressing the F1
key on your keyboard.

This will open the appropriate User Guide.  You can also consult the User Guides by selecting
one from the Contents tab in Help Topics, or by clicking the Index tab and searching for the
name of the database.

16.2 Help on Fields

When you are presented with a list of fields, for example if you click a field button on the
Form Search screen or click Set Filter while preparing to export or print records, you can
usually get Help on an individual field by clicking it once and then pressing the F1 key on
your keyboard.
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16.3 Searching for Help

You can search the predefined index terms to look for Help on any aspect of the JUSTIS 5
software or the JUSTIS 5 range of databases.  From the JUSTIS 5 program, click the Help menu,
then Contents & Index, and then the Index tab.  Type in the first few letters of a word, and
the closest matching index terms will be displayed.  Double-click an index term to see the
Help topic.

If the Help system is already open, click the Index button on the button bar to open the
Index tab.

16.4 Context Sensitive Help

Most of the screens and dialog boxes in the JUSTIS 5 software have a specific Help topic that
explains what they are for and how to use them.  If there is a Help button, clicking it will
display the appropriate Help topic.  If there is no Help button, pressing the F1 key on your
keyboard will normally display the appropriate topic.  However, if there is a list of databases
or fields displayed, you may get Help on the selected database or field.
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17 Utility Programs

In addition to the main program, JUSTIS 5 includes a few utilities that you may occasionally
need to use.

17.1 Check Utility

The Check utility interrogates some of the files that are used by JUSTIS 5 and produces a list
of their version numbers.  This information can assist the Justis Publishing Help Desk in
diagnosing obscure problems.

If you need to use the program, its default location is:

c:\context\justis\bin\check.exe.

Double-click the program name or the icon in Windows Explorer (or File Manager) to start it,
then click Check Version on the File menu.  A file called check.log will be prepared, stored
in your temp directory, and displayed on your screen using Notepad.

17.2 Import Utility

The Import utility allows you to keep Query History files produced under JUSTIS Windows or
JUSTIS/LR (the predecessors of JUSTIS 5) when you upgrade to JUSTIS 5.

If you need to use the program, its default location is:

c:\context\justis\bin\import.exe.

Double-click the program name or the icon in Windows Explorer (or File Manager) to start it,
then:

1) Click the File menu, and then the Import JUSTIS Queries... item.

2) Select the directory where your Query files are stored (the default is c:\justis).

3) Select a Query file, and click the Open button.

The program will convert your stored queries to the new format, and add them to the Query
History (see Sections 7.5 and 8.4) in JUSTIS 5.

17.3 License Utility

The License utility is installed when you install the JUSTIS 5 software, but is only needed if
you subscribe to The Law Reports or Irish Reports and Digests.  When you start an unregistered
copy of either of these products, you will see a flashing warning message in the status bar.

To register, click the Start button, then point to Programs, then to Context, and then click
the License icon.  This will display the Reference for your installation.

Telephone or e-mail the Justis Publishing Help Desk (see Section 18) and tell them your
Reference.  Type in the password that they give you, and click OK to register your copy of the
database.

NOTE:  If you delete and re-install the software on the same computer, or if you want to use
it on a different stand-alone computer, you will need to obtain a new password.

You can also register from within the JUSTIS 5 program when you select either The Law
Reports or Irish Reports and Digests. 
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17.4 Transfer Utility

You can use the Transfer utility to copy one or more databases from CD-ROM onto the hard
disk in your computer or on a network server.  This will make accessing the data much faster,
and will also allow you to have data from more than one CD-ROM available simultaneously
if (like most people) you have only one CD drive in your computer.  The utility will also make
the required adjustments to the JUSTIS 5 settings, making the transferred database(s) available
and recognisable to the software.

For all databases except The Law Reports, you must transfer both the data and the indexes.

17.4.1 Starting the Transfer Utility

To start the Transfer utility, click the Start button, then point to Programs, then to Context,
and then click the Transfer icon.  It will show you a list of all the JUSTIS 5 products it can
find.

The left-hand pane shows an expandable list of all of the products and databases that are
available to be transferred; the right-hand pane shows the ones that have already been
transferred.  A plus, a closed folder or a closed book icon indicates that more detail is available;
click the plus icon or double-click the closed icon.  A minus, an open folder or an open book
icon indicates that no more detail is available; click the minus icon or double-click the open
icon to show less detail.

17.4.2 Obtaining Details of Indexes and Data

To obtain information about the size and location of an item, click the required Index or Data
item and then click the Details button on the toolbar.  Alternatively, right-click the required
item.

17.4.3 Transferring Indexes or Data to a Hard Disk

To transfer indexes, data, databases or groups, either click the appropriate icon and then the
Transfer button, or hold down the left mouse button and drag the icon to the right-hand
pane.  Confirm the details of the item, and then specify a drive and directory.  You can use
the same directory for any number of databases.

For all databases except The Law Reports, you must transfer both the data and the indexes.

The transferred item will disappear from the Available section and appear in the Transferred
section.  This can take from a few seconds to several minutes, depending on the speed of your
CD drive and the quantity of data.
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It is possible to transfer the Index and Data components separately and to different
destinations, which can be useful if you do not have enough space on one disk.

17.4.4 Refreshing the Product Display

The Transfer utility maintains a list of locations (CD drives, mapped network drives and UNC
paths) in which a JUSTIS 5 product has been found.  When you run the Transfer utility it
searches known locations for available JUSTIS 5 products, and displays the list in the Available
Databases section.  If the available products/CD-ROMs change, e.g. you replace the Index disc
of eLR with the Data disc, click the Refresh button on the toolbar to update the list.

17.4.5 Scanning for New Locations

To make the Transfer utility search for new locations for JUSTIS 5 products, for example, if a
new product has been added to a network or an existing product has been moved to a location
not previously used by JUSTIS 5, click the Scan button on the toolbar.

If you know the new location, enter the details, such as the drive letter or the UNC path, and
click OK.  If you do not know the new location, leave the text box empty and click OK; all the
mapped drives will be scanned.

You can click the down arrow to select from a scrollable list of all the known locations of
JUSTIS 5 products on your system, and then click OK to start the scan.

17.4.6 Removing Transferred Indexes and Data

To remove transferred files from your hard disk, click the required item, and then click the
Remove button on the toolbar.  Alternatively, click the item, hold down the left mouse
button, drag the item to the left hand section, and release the button.

The selected item will disappear from the Transferred section, and, if the item is found on an
available CD-ROM, it will appear in the Available area.

Do NOT try to remove transferred files from your hard disk by deleting them; it is not easy to
know which ones to delete, and you will upset the list of locations that JUSTIS 5 maintains.

17.5 Localisation and Language utility

The JUSTIS 5 Setup program allows you to select the language for the textual elements of the
interface.  The Setup program detects the language setting of your Windows installation and
offers an appropriate choice, but you can select an alternative.

This does not change the language used in records in the JUSTIS 5 databases.

After installation, you can use the Language utility to switch from one language to the other.

Click the Windows Start menu, then Programs, then Context, and click Language.
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1) Click the black down arrow so that the list of languages appears.

2) Click the language that you want to use.

3) Click OK.
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18. Getting in Touch with Justis Publishing

You can get in touch with Justis Publishing for Help Desk, sales, training or other enquiries at:

Justis Publishing Limited
Suite 3
Grand Union House
20 Kentish Town Road
London
NW1 9NR
United Kingdom

DX 121900 Kentish Town 3

Telephone: 020 7267 8989  (00 44 20 7267 8989 from outside UK)

Facsimile: 020 7267 1133  (00 44 20 7267 1133 from outside UK)

e-mail: helpdesk@justis.com for more help
sales@justis.com for sales and general enquiries
training@justis.com for training enquiries
customerservices@justis.com for account enquiries

WWW http://www.justis.com

Office hours are 09:00 to 17:30 Monday to Friday.
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Outline, 41

P
Page button, 39
Page references, 48
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Password protection, 61-62
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Phrase searching, 14
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export directory, 60
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password protection, 61-62
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Profiles, 2, 33-37

exporting, 36-37
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Proximity searching, 14-15
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Q
Query history, 18-19, 25-26, 29-30

customising, 26, 30
importing, 67

Quick Search screen, 17-19
buttons, 17
J-Link button, 19
Publication Reference button, 18

Quotation marks, 14

R
Recommended computer specification, 5
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Regulations,

J-Link, 52
Requirements to run JUSTIS, 5
Right mouse button, 41
Round brackets, 14
RTF export, 36-37, 43-44

S
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Scrolling, 33, 39-40
Search operators, 13-16
Search queries, 2
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history, 25-26, 29-30
notes, 26, 29
re-using, 18-19, 25-26, 29-30
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finding a word in a document, 40-41
Form Search screen, 21-26
from within a document, 51
General Search screen, 27-30
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notes, 55-56
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operators, 2, 13-16
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phrase searching, 14
proximity searching, 14-15
proximity equivalents, 15
Quick Search screen, 17-19
results, 18
wild cards, 13-14

Setup, 5
Square brackets, 15, 16, 27-28
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J-Link, 52
Subsequent documents, 50
Symbols for operators, 13, 15
System requirements, 5
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TO operator, 15-16
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Top of Page button, 40
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Trail, 50-51
Transfer Utility, 68-69
Treaties,

J-Link, 19, 52
Tutorial, 7

U
User defined dictionary, 24-25
User preferences, 59-60

V
Viewing documents, 34, 39
Viewing the next hit, 42

W
Wild cards, 13-14
WITHIN operator, 14-15
Word index, 23-24, 28-29
Word root, 13-14, 24, 28
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